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Copyright
Copyright © 2011 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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For your safety

QUALIFIED SERVICE
Only qualified personnel may install or repair phone equipment.

ACCESSORIES AND BATTERIES
Use only approved accessories and batteries. Do not connect incompatible products.

CONNECTING TO OTHER DEVICES
When connecting to any other device, read its user’s guide for detailed safety instructions. Do not connect
incompatible products.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Ni-Cd/NiMh batteries, discharge the battery from time to time by leaving the
product switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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Company policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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  Product selection
RM-704 (Nokia C2–00) is a GSM Quad-band phone, supporting EGSM 900/1800 bands.

Figure 1 RM-704 (Nokia C2-00) product picture

  Phone features

Hardware features
• One internal SIM slot under battery

• One external SIM slot, hot-swap enabled

• HW16, Dual-band variants: EGSM 900/1800 & GSM900/1800 – Edge down link only

• Combo 32 MB Flash, 16 MB SDRAM

• Codecs supported: FR, EFR, HR, AMR

• SIM support: 3volt, 1.8volt

• 128x160 TFT display (ACF)

• microSD card slot, hot-swap supported

• VGA Camera

• Long battery life time (BL-5C; 1020mAh)

• Nokia AV connector

• Stereo FM Radio & Radio recording, RDS
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• Bluetooth

• BTHCost4.0

• 3in1 speaker

• Clapton microphone

• Speaker loudness: 103db

• 3.5mm audio jack

• Micro USB

SW features (S40 SPR10.4)
• Smart Dual SIM, swap external SIM without rebooting

• UI: D5, Entry S40 UI, connect UI, 3soft keys, 5way Navi™ key

• Full MP3 player

• Bluetooth connectivity

• Stereo FM radio and recording

• MP3 ringing tones

• Java MIDP 2.1

• OMA DRM 2.0

• WAP 2.0

• MMS 1.3

• SyncML 1.2

• Native Email Client

• Nokia Xpress Audio messaging

• Theme 3.0

• Organizer with local calendar

• Expense manager

• Advanced calculator

• Converter II

• FOTA/NSU

Applications
• Nokia Cherry 2.5

• Ovi Life Tool 1.7

• Nokia Messaging service 2.0

  Accessories

In-box:
• Phone: Nokia C2–00

• Battery: BL-5C

• Chargers: AC-3 (China use AC-8C and CA-100C)

• Headset: WH-102

For out-box accessories, please refer to enhancement list document.
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  Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T)
(mm)

Weight (g) Volume (cm3)

Transceiver with BL-5C
1020 mAh Li Lion
battery pack

108 x 45 x 14.65 74.1 67.9

Battery endurance

Battery Talk time Stand-by time

BL-5C with
1020 mAh Li
Lion standard
battery

Best Talk Time ECTEL Talk Time Best Stand-by Time ECTEL Stand-by Time

11.5 hours 5.7 hours 570 hours 460 hours

Note: Variation in operation time will occur depending on SIM card, network settings and usage.
Talk time is increased by up to 30% if half rate is active and reduced by 5% if enhanced full rate is
active.
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  Service tools

Product specific tools
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-704. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.

SS-255 Protection plate

SS-255 is designed as protection plate working with SS-256 for OKI
soldering machine.

SS-256 Blowing nozzle

SS-256 is a blowing nozzle which can be used with protection plates
for different soldering machines.

SS-257 Protection plate

SS-257 is designed as protection plate working with SS-256 for Martin
soldering machine.

General tools
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-704. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• Software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• Software controlled BSI values

• Regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start service software.

Note: Service software enables CU-4 regulators via USB when
it is started.

Reconnecting the power supply requires a service software
restart.
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FPS-21 Flash prommer

FPS-21 sales package:

• FPS-21 prommer

• AC-35 power supply

• CA-31D USB cable

FPS-21 interfaces:

Front
• Service cable connector

Provides Flashbus, USB and VBAT connections to a mobile device.

• SmartCard socket

A SmartCard is needed to allow DCT-4 generation mobile device
programming.

Rear
• DC power input

For connecting the external power supply (AC-35).

• Two USB A type ports (USB1/USB3)

Can be used, for example, for connecting external storage memory
devices or mobile devices

• One USB B type device connector (USB2)

For connecting a PC.

• Phone connector

Service cable connection for connecting Flashbus/FLA.

• Ethernet RJ45 type socket (LAN)

For connecting the FPS-21 to LAN.

Inside
• Four SD card memory slots

For internal storage memory.

Note: In order to access the SD memory card slots inside
FPS-21, the prommer needs to be opened by removing the
front panel, rear panel and heatsink from the prommer body.
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MJ-300 Module jig

Module jig MJ-300 can be used for flashing via USB and RF, battery and
system testing.

The main functions are:

• Powering with external power

• CU-4 interface adapter to phone (requires SS-227)

• WLAN/BT/GPS RF-interfaces with probes

• GSM/WCDMA RF-interfaces with probes

• BSI mode selector (Tabby and Lynx interface, selected with battery
cable)

• VBATT interface (Tabby and Lynx interface, selected with battery
cable)

• CA-128RS cable is used together with this jig for RF testing

PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.

RJ-230 Soldering jig

RJ-230 is a soldering jig used for soldering and as a rework jig for the
engine module.

SRT-6 Opening tool

SRT-6 is used to open phone covers.

Note: The SRT-6 is included in the Nokia Standard Toolkit.
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SS-227 Interface for CU-4
control unit

SS-227 is designed for regional Central Services to be able to use CU-4
with MJ-300 module jig. With SS-227, CU-4 can be used for battery
testing.

The main functions of SS-227 are:

• CU-4 interface adapter to MJ-300

• BSI mode selector (Lynx and Tabby mode selection)

• VBATT interface

All functions are performed in the CU-4. Calibration voltages and
currents e.g. are protected and monitored by the CU-4 interface
software (protection for over-current, overvoltage and reverse
voltage).

SS-93 Opening tool

SS-93 is used for opening JAE connectors.

Note: The SS-93 is included in Nokia Standard Toolkit.

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-21 when DCT-4 phones are
flashed.

Cables
The table below gives a short overview of service devices that can be used for testing, error analysis, and
repair of product RM-704. For the correct use of the service devices, and the best effort of workbench setup,
please refer to various concepts.

CA-101 Micro USB cable

The CA-101 is a USB-to-microUSB data cable that allows connections
between the PC and the phone.
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CA-128RS RF tuning cable

Product-specific adapter cable for RF tuning.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-21 to a PC. It is included
in the FPS-21 sales package.

CA-89DS Cable

Provides VBAT and Flashbus connections to mobile device
programming adapters.

CA-99PS Adapter

CA-99PS adapter, 3.5 jack to 5.5 plug.
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PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.

XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WCDMA/WLAN: 0.6+-0.1dB
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  Service concepts

POS (Point of Sale) flash concept

Figure 2 POS flash concept

Type Description

Product specific tools

BL-5C Battery

Other tools

PC with Care Suite

Cables

CA-101 Micro USB cable
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Flashing, certificate restore and product code change

Figure 3 Flashing, certificate restore and product code change

Type Description

Product specific devices

BL–5C Battery

Other devices

FPS-21 Flash prommer box

AC-35 Power supply

PK-1 SW security device

SX-4 Smart card

PC with service software (Phoenix)

Cables

CA-101 Micro USB cable

USB cable
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Flashing, certificate restore, product code change and EM calibration

Figure 4 Flashing, certificate restore, product code change and EM calibration

Type Description

Product specific tools

MJ-300 Module jig

Other tools

CU-4 Control unit

FPS-21 Flash prommer box

PK-1 SW security device

SX-4 Smart card

PC with service software (Phoenix)

Cables

CA-101 Micro USB cable

CA-89DS Service cable

CA-99PS Adapter

PCS-1 Power cable

USB cable
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BB and RF tuning

Figure 5 BB and RF tuning

Type Description

Phone specific devices

MJ–300 Module jig

Other devices

CU-4 Control unit

SS-227 CU-4 interface part

FPS-21 Flash prommer box

PK-1 SW security device

SX-4 Smart card

PC with service software (Care Suite)

Measurement equipment

Cables

CA-101 Micro USB cable

PCS-1 DC power cable

XRS-6 RF cable

USB cable

GPIB control cable

CA-128RS Product specific RF adapter cable
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  Baseband Troubleshooting
The following sections contains guidelines how to identify and correct basic baseband related faults. Access
to normal LAB equipment (power-supply, digital multi-meter and oscilloscope) is a prerequisite for following
the guidelines. Due to the small size of the components and test-points, access to a microscope or magnifying
glass is recommended.

  Introduction to BB Troubleshooting
Initial baseband troubleshooting normally involves the measurements of various power supply voltages and
control signals. The location on the most important test-points is indicated in the following figure:

Figure 6 Baseband test point locations

  Non re-workable Baseband Components
The XGold 213 V2.1S GSM controller IC D3100 is non-reworkable. This means that if failure diagnostics leads
to the conclusion of defective D3100, the PWB has to be swapped with a working unit.

  Baseband main troubleshooting

The following sections will contain in-depth trouble-shooting guides for various areas of the baseband circuit.
It is assumed that a battery simulator containing a valid BSI resistance is used to supply the phone, or a valid
battery is used.
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Phone does not power on

Troubleshooting flow

Power supply troubleshooting

High current
If the phone draws excessively high current upon power on or insertion of battery, it means that VBAT or a
LDO output is shorted.
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Listing 1: High current when battery is inserted, I>500mA;

Figure 8 High current when battery inserted

Refer to the following picture:

Figure 9 IR picture showing component overheat
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Listing 2: High current after pressing power-on key, 100mA<I<500mA.

Figure 11 High current after pressing power-on key
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No current when pressing power on key

Figure 12 No current when pressing power on key

Clocking system troubleshooting

26 MHz clock does not work
If the 26 MHz crystal does not work, it may be due to B7100 malfunction or a soldering defect.
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Figure 13 26 MHz Clock does not work

32 KHz RTC clock does not work
If the 32 KHz crystal does not work, it may be due to B3000 malfunction, matching capacitor or B3000
soldering defect.
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Figure 14 32 KHz RTC clock does not work

Flash programming troubleshootin

Context
Flash programming can be done via the USB test points or the USB connector. If there is a connectivity issue
(open/short circuit) under BGA chip, it may also cause programming failure. It is assumed that the integrity
of the USB connection is verified prior to flashing troubleshooting.

The Phoenix tool can give some useful information about the failure as indicated in the following
programming troubleshooting flow.
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Troubleshooting flow

Main memory troubleshooting

Context
Possible issues happen on the main memory could be: image corruption, soldering issue or flash chip
damaged.
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Troubleshooting flow

Charging troubleshooting

Can not identify charger
When inserting the wall adaptor into the phone, the phone will detect a valid voltage if charger output
voltage is 4.6 – 9.3V. But if something is wrong with the voltage detect/measurement circuit, then the phone
cannot correctly identify the charger.
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Figure 15 Cannot identify charger

No charging current (cannot charge battery fully in expected time)
When the phone is in constant current or constant voltage charge state, the average charging current is
controlled by phone SW. The current is feed into battery though the V2204 transistor, the phone measures
charging current by sampling the voltage over resistor R2208. If there is something wrong at this path, the
charging current may be out of specification. It is assumed that phone can detect the presence of the charger,
otherwise please refer to the above section.
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Figure 16 No charging current

SIM card troubleshooting

Cannot identify SIM card
The hardware of the SIM interface from XGOLD213 (D3100) to the SIM connector (X2750) can be tested without
a SIM card. When the phone is switched on, the phone first checks for a 1.8V SIM card, and then for a 3V SIM
card. The phone will try this several times, where after it will display “Insert SIM card”.

Figure 17 Cannot identify SIM card
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Figure 18 SIM voltages, no ATR

SIM card rejected
The error “SIM card rejected” means that the ATR message received from SIM card is corrupted, e.g. data
signal levels are wrong. The first data is always ATR and it is sent from card to phone. For reference a picture
with normal SIM power-up is shown below.

Figure 19 SIM voltages, normal startup at 3V
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Dual SIM troubleshooting
Troubleshooting SIM problems on a dual SIM product is very similar to the procedures outlined in the above
section. The presence of the dual SIM IC is detected by the self-test routine, and as such it can be assumed
that presence and interface towards the BB IC is verified if the self-test passes. The troubleshooting guides
will as a consequence focus on dual SIM IC <-> SIM card related problems. It also assumed that troubleshooting
on SIM1 is done using only one SIM card, which is inserted either in slot 1, and troubleshooting on SIM2 is
done using 2 SIM cards, so both slots needs to be occupied.

SIM 1 not recognized

Figure 20 SIM 1 troubleshooting flow
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SIM 2 not recognized

Figure 21 SIM 2 troubleshooting flow

USB troubleshooting

Context
If the phone cannot be detected by PC when the USB cable is inserted, this means that communication
between phone and PC can not be setup. This may be due to soldering issue or a malfunction in the ESD
protection device.
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Troubleshooting flow
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Figure 22 Pin 3 of V2202

  User interface troubleshooting

Keyboard troubleshooting

Context
One or more keys don’t function at all.
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Troubleshooting flow

Display troubleshooting

Blank display
The display doesn’t show any information at all when phone is powered on. XGOLD connects the LCD via the
serial port. If the communication between XGOLD and LCD has problems, the XGOLD may be not be able to
initialize LCD correctly. The XGOLD also feeds 2 power supplies to the LCD: VAUX and 1V8, if these 2 power
supply work abnormally, the LCD also doesn’t work.
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Figure 23 Blank display troubleshooting flow

Display is corrupt
The display contains missing or fading segments or color presentation is incorrect. Since ACF assembling is
used, it cannot be repaired.

Backlight troubleshooting

No backlight
The backlight is driven by a DC-DC converter. The LCD backlight LED’s and the keypad LED’s are in connected
in serial path. If any component on this serial path is open circuit, there is no backlight.
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Figure 24 No backlight troubleshooting flow

  Camera interface troubleshooting

Camera troubleshooting instructions
Camera troubleshooting involves debugging on two interfaces; the interface between the camera module
itself and the camera interface IC N3000, and debugging on the interface between N3000 and the baseband
IC D3100. Troubleshooting on interface between camera and N3000 is outside the scope of this specification.
In the following troubleshooting guide it is assumed that the integrity of this interface is already verified
and valid signal are present on the inputs of N3000.
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Figure 25 Interface signals between D3100 and N3000

The above figure shows the interface signals between N3000 and D3100 when the camera is active:

Yellow: Pixel Clock signal J3002

Red: Data bit 0 J3003

Green: Hsync J3005

Blue: Vsync J3006

Actual pixel clock frequency, Vsync and Hsync frequency and data content will depend on the camera used
(resolution, frame-rate) and operating mode (still picture capture, video recording, viewfinder mode).
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No valid data from Camera interface IC

Figure 26 Camera interface IC troubleshooting guide

Configuration of the camera interface chip IC:

CCP_CLASS_SEL = GND: SMIA Class 0, Strobe pins functions as Clock inputs (ACME VGA module)

CCP_CLASS_SEL = 1.8V: SMIA Class 1, Strobe and Data. (2MP Gandalf module)
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  Audio troubleshooting

Audio troubleshooting test instructions
Audio troubleshooting using phoenix:

Figure 27 Phoenix audio test window

RM-704
BB Troubleshooting and Manual Tuning Guide

Page 3 – 26 COMPANY CONFIDENTIAL Issue 1
Copyright © 2011 Nokia. All rights reserved.



Figure 28 PWB audio test point

Internal microphone troubleshooting

Steps:
1 Connect phone with Phoenix.

2 Open “audio test” window from “Testing –> Audio test”, as shown in Figure Phoenix audio test window
above.

3 Select “Hp microphone in Ext speaker out”.
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4 Select “Loop” as “On”.

5 Input sound at microphone port, for example 94dB SPL 1kHz.

6 Check if signal is detected at HS_EAR_L/R pads, as shown in Figure “PWB audio test points” above.

Figure 29 Test arrangement for microphone

Figure 30 Internal microphone troubleshooting flow
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Internal earpiece troubleshooting

Steps:
1 Connect phone with Phoenix.

2 Open “audio test” window from “Testing –> Audio test”, as shown in Figure Phoenix audio test window
above.

3 Select “Ext microphone in Hp speaker out”.

4 Select “Loop” as “On”.

5 Input signal to HS_MIC/GND pads, as shown in Figure PWB audio test point above, for example 100mVpp,
1kHz.

6 Check if sound is heard in earpiece.

Figure 31 Test arrangement for earpiece
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Figure 32 Internal earpiece troubleshooting flow

IHF speaker troubleshooting

Steps:
1 Connect phone with Phoenix.

2 Open “audio test” window from “Testing –> Audio test”, as shown in Figure Phoenix audio test window
above.

3 Select “Ext microphone in IHF speaker out”.

4 Select “Loop” as “On”.

5 Input signal to HS_MIC/GND pads, as shown in Figure PWB audio test point above, for example 100mVpp,
1kHz.

6 6) Check if sound is heard in IHF.
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Figure 33 Test arrangement for IHF speaker

Figure 34 IHF speaker troubleshooting flow

External microphone troubleshooting

Steps:
1 Connect phone with Phoenix.

2 Open “audio test” window from “Testing –> Audio test”, as shown in Figure Phoenix audio test window
above.

3 Select “Ext microphone in Ext speaker out”.

4 Select “Loop” as “On”.

5 Input sound at microphone port, for example 94dB SPL 1kHz.

6 Check if signal is detected at HS_EAR_L/R pads, shown in Figure PWB audio test points above.
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Figure 35 Test arrangement for external microphone

Figure 36 external microphone troubleshooting flow

Headset speaker troubleshooting

Steps:
1 Connect phone with Phoenix.

2 Open “audio test” window from “Testing –> Audio test”, as shown in Figure Phoenix audio test window
above.

3 Select “Ext microphone in Ext speaker out”.

4 Select “Loop” as “On”.

5 Input signal to HS_MIC/GND pads, as shown in Figure PWB audio test point above, for example 100mVpp,
1kHz.

6 Check if sound is heard in headset.
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Figure 37 Test arrangement for headset speaker

  FM radio troubleshooting

FM radio troubleshooting

Context
FM radio problems can fall into two categories; not possible to tune into a station when headset cable is
inserted, or it can tune in on a station (Station ID and valid signal strength indicated in display) but there is
no audio. In the latter case please refer to “IHF speaker troubleshooting” or “Headset speaker
troubleshooting” for trouble shooting the downlink audio path and headset detection function. It is assumed
that live FM stations with sufficient signal strength are available on the point of service, and that a dedicated
FM signal generator is not used during troubleshooting.
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Troubleshooting flow
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  Memory card troubleshooting

Cannot detect memory card

Context
Quantum support SD/MMC card.

Troubleshooting flow

  Baseband manual tuning guide

Certificate restoring BB5

Context
This procedure is performed when the Combo Memory is replaced.

Hardware and Software Setup:

RM-704
BB Troubleshooting and Manual Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 – 35
Copyright © 2011 Nokia. All rights reserved.



• Latest Phoenix Service Software supporting phone model

• Latest phone model specific Data Package

• FPS--10 or 21 Flash prommer

• SX-4 Smart Card with Enabled Certificate Restore feature

• Phone model specific Module Jig or Generic Module Jig

Refer to the setup in Service Concept.

Steps
1. Connect phone and scan product, read phone information to check communication with phone. Select

Tools –> Certificate Restore BB5 in the menu.

2. Provide Tucson Password and PIN code. Please note that characters are case sensitive.

3. Select OK, Phoenix will read product information from phone.

4. Product code shown on the UI does not matter, because during restoring it will be replaced by the product
code which is the latest one stored in Nokia system.
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5. It is recommended to perform “Restore” function without selecting “Flash Product” –– option to avoid
possible SW downgrade which causes the phone to die.

6. Information from phone and Smart Card are read and connection to Tucson server is established.

7. Information from Nokia system is retrieved and programmed in the phone.
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8. After programming confirmation about successful event is sent to Nokia system.
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Next actions
After a successful rewrite, you must retune the phone completely. (RF and BB)

Energy management calibration

Context
Energy Management calibration is performed to calibrate the settings of the AD converters in several channels
to get an accurate AD conversion result.

Hardware and Software Setup:
• Latest Phoenix Service Software supporting phone model

• Latest phone model specific Data Package

• FPS--10 or 21 Flash prommer

• Supply 12V DC from an external power supply to CU-4 to power up the phone

• The phone must be connected to a CU-4 unit with a product-specific Module Jig or generic module jig.

Refer to the setup in Service Concept.

Steps
1. Connect CU-4 with Module Jig, and place the phone module to the Module Jig -> Mode Switch on Flashing

+ EM CALIB.

2. Start Phoenix service software.

3. Choose File -> Scan Product.

4. Choose Tuning -> Energy Management.

5. To show the current values in the phone memory, click Read.

6. Click Tune & Calculate.
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7. The new calibration values are shown in the calculated column. If the new calibration values seem to be
acceptable click Write to store the new calibration values to the phone permanent memory.

8. Click Read, and confirm that the new calibration values are stored in the phone memory correctly.

9. End the procedure and close the Energy Management window.
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  Introduction to RF Troubleshooting
For the RF troubleshooting, generally 2 types of measurements are used: RF measurements and LF
measurements.

RF measurements are done with a spectrum analyzer (or spectrum analyzer alike?) and a high-frequency
probe, e.g. Agilent E4440A. Note that the test jig has some losses, which must be taken into consideration
when calibrating the test system.

LF (low frequency) and DC measurements should be done with a 10:1 probe and an oscilloscope. The probe
used in the following is a 10mW/10pF probe. For the other types of probes the voltages displayed may be
slightly different. Always make sure the measurement setup is calibrated when measuring RF parameters on
the antenna pad. When re-aligning the phone, the loss in the module repair jig should be included.

Most RF semiconductors are static discharge sensitive, i.e. ESD protection must be added during repair
(ground straps and ESD soldering irons). The FEM and the X-GOLD213 are also sensitive to moisture, i.e. these
parts must be pre-baked prior to soldering.

Key components are described in this document but there are also a lot of discrete components (resistors,
inductors and capacitors) where the troubleshooting is done by checking if soldering of the component is
done properly and checking if the component is missing from PWB. Capacitors can be checked for short-
circuiting and resistors for value by means of an Ohm meter. However it should be noted that in-circuit
measurements should be evaluated carefully.

  Non re-workable RF Components
The non-reworkable component for the Quantum is the X-GOLD213 (D3100). All other components are re-
workable.

Figure 38 D3100 is the non-reworkable components on PWB

  Maintenance Overview

When the phone is received at the service centre, it is fully assembled, and it is the objective to identify the
failure area in the phone by doing fast troubleshooting and then locate the failed component(s). Since the
X-Gold213 IC is a non-replaceable component, it should be the primary task to identify whether the failure
is related to this component or not. In case of failure of the X-GOLD213 the current PCB will be replaced by a
new fully mounted PCB. The intention of the troubleshooting procedure is to find the failing component(s).
After this a re-tuning + verification of the phone is needed in order to secure passes of all RF parameters and
no more failures will be present.
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Before sending the phone back to the customers a short verification step in normal mode + live network call
will be performed.

The Maintenance steps can be seen in the figure below:

Maintenance step 1
Step 1 is where the phone (MS) is fully assembled, i.e. the RF production connector cannot be used. The
purpose is to perform a quick identification of the failure mode using MS self test. The self-test feature will
not be able to detect the failed component, but in best case it can detect the failure area/functionality. Note
that the self test might not catch all failures.

Purpose of step 1:
• Fast identification of any failures when phone is assembled;

• To identify the area of the failures in order to give the operator (Service maintenance operator) further
information where to debug. (Note: Self-test will not be able to specify which component(s) is failing only
which functionality is failing.)

Maintenance step 2
Step 2 is where the phone (MS) is disassembled and the RF production connector can be used, i.e. the antenna
is not mounted. The purpose of this step is to identify the failing component(s) and replace it. In this step
the troubleshooting will be made.

Purpose of step 2:
• Identify the failure when phone is disassembled;

• Troubleshooting in order to find the specific failing component(s) and replace it/them.

Maintenance step 3
The Maintenance Step 3 is the local mode verification step. Note that this can be used for both troubleshooting
and verification.

Purpose of step 3:
• In case of the MS self-test performed in Maintenance Step 1 didn’t show any errors the verification should

identify where the error is located (on functional level);

• In case a component(s) has been replaced after troubleshooting, this step should verify that the phone
can pass all RF test after recalibration or:

a Identify if the replaced components was the component(s) causing the failure.

a Detect if other failures are present after replacing.

• To make a final calibration and verification (local mode) to make sure that the phone passes all RF limits
and requirements.
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Maintenance step 4
In Maintenance step 4 the phone will be assembled and a short test in signalling mode in order to verify that
the assembled phone with full mechanic and antenna can pass finial UI requirements in Normal Mode, i.e.
Signalling Mode and if the phone is able to do a voice call.

Purpose of step 4:
• Finial verification step using normal mode of the full assembled phone before sending it back to the

customer;

• To verify the phone is working in live network.

  Maintenance working flow

Overview
The Maintenance step 1 is the maintenance step where all self-tests are performed on the fully assembled
MS. In some case the Self-tests will detect failure i.e. tell the maintenance operator where to debug. However
in other cases the Self-test will not detect any failure however this doesn’t mean that a failure is present. In
order to locate the area of the failure it’s recommended to run verification test (Maintenance step 3) in order
to give the Maintenance operator better hint where to trouble shoot.

Below is the different working flow described depending on outcome of the different Self-tests.

Case 1: All Self Tests Passed
Below is the working flow for the case where all Self-test passed illustrated.

The phone passes all the Self-tests meaning that the Self-Test was not able to detect any failure – however
it must be assumed that a failure is present.

In order to locate the area of the failure, the RF verification in Maintenance step 3 need to be executed. The
verification step will highlight in which area the failure is present and where to start to troubleshoot.
Debugging and troubleshooting are described in the Maintenance Step 2.

After the troubleshooting i.e. finding and replacing the failing components(s) the next step is to re-tune
(calibrate) and do RF verification (Maintenance step 3). This is done in order to secure that all failures have
been removed and no further failures are present. The MS passes needs to pass all RF related test. Finally the
MS is assembled in Maintenance step 4 and verified in normal mode.

Case 2: X-Tal, Antenna detection and FEM ID Self-Test Failed
Below is the working flow illustrated for the case where all Self-test fails the X-Tal, Antenna detection or FEM
ID Self-test in the Maintenance step.
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Debug and troubleshooting should be performed in the area of the Self-test failure i.e. if it is the X-tal self-
test that fails then do the X-Tal troubleshooting etc. After the troubleshooting i.e. finding and replacing the
failing components(s) the next step is to re-tune (calibrate) and do RF verification (Maintenance step 3). This
is done in order to secure that all failures have been removed and no further failures are present. The MS
passes needs to pass all RF related test. Finally the MS is assembled in Maintenance step 4 and verified in
normal mode.

Case 3: RF Internal Loopback failure
Below is the working flow described in the case where the phone fails at RF internal loop back self-test in
the Maintenance step 1.

The Internal Loop Back Self-test is a special test mode where the TX part of the X-GOLD213 is configured to
transmit on a RX frequency. This signal is weak amplified in the PA of the FEM and by the antenna switch of
the FEM directed to the RX port (not the antenna port as normal operation!) and then looped back to the RX
input of the X-GOLD213. The receiver of the X-GOLD213 is then able to measure how much of the transmitted
output power is looped back.

Since a fail in the RF loopback test can be a failure in the TX or RX (LB or HB) and the RF internal loopback self-
test is not able to highlight this, it is recommended to do a verification step in the maintenance step 3 – with
the only purpose to get the info if the failure is in the TX or RX path.

After troubleshooting i.e. finding and replacing the failing components(s) the next step is to re-tune
(calibrate) and do RF verification (Maintenance step 3). This is done in order to secure that all failures have
been removed and no further failures are present. The MS passes needs to pass all RF related test. Finally the
MS is assembled in Maintenance step 4 and verified in normal mode.

  Maintenance step 1—Self test

Maintenance step 1 — Self test
Run all self-tests in order to clarify if the Self-Test can detect any failures.
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  Maintenance step 2 –Debugging and troubleshooting

Maintenance step 2 –Debugging and troubleshooting
In this stage the phone is disassembled. The goal of this step is to identify the failed component(s) either by
visual inspection or by troubleshooting.

Visual inspection check flow
The purpose of the visual inspection is to try by visual to identify the area or component of root cause i.e.
locate burned components (mal colure), destroyed components, misplaced components and other visual
abnormalities.
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RF Troubleshooting: X-Tal debug check flow
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RF Troubleshooting: Antenna detection check flow
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RF Troubleshooting: AFC troubleshooting

Receiver troubleshooting

Receiver troubleshooting overview
If the phone failure identified at maintenance step1&3 is indicating failure at the receiver, RX troubleshooting
must be executed.

Abbreviation and terms:
Specific abbreviations used in RX troubleshooting workflow are described here:

Abbreviation Definition

RXLB_MN C7115, L7100, C7126

RXHB_MN C7114, L7101, C7129

FEM_RxCtl VC1, VC2, VC3,

FEM_RxCtrlRes R7106, R7110, R7113

FEM_RxCtrlCap C7107, C7110, C7132

FEM_BatComp L7707, C7135, C7125, C7117, C7111
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Figure 39 RX checkpoints and component overview (measurement point marked with blue)

RX LB troubleshooting
The test signal from GSM tester must be a continuous signal, as the phone has no means of synchronizing to
a GSM burst signal in local mode. To excite the RSSI detector in the same way a modulated GSM signal does,
the test signal must either be GMSK modulated (Pseudo-random bit sequence (PRBS)) or an un-modulated
CW-signal with 67.7kHz offset from center frequency.
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Figure 40 X-Gold RX pin volts @ L7100(LB) / L7101(HB)

Figure 41 RX LB FEM logic waveform (C1:VC1; C2:VC2; C3:VC3)

Table 1 Power supply voltages for the X-GOLD213 IC RF sub-system

Name Ball No. Test point Function

VBAT G14 C7134 3.6V typ. Battery voltage, supply
voltage of D2B LDO

VDDRF2 G13 C7106 2.5V D2B output voltage, part of RF
supply
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Name Ball No. Test point Function

VRF1 H10 C7121 1.8V DCDC output voltage, supply of
1.3V LDOs

VDDTRX B14 C7124 1.4V Transceiver supply

VDDTDC B12 C7131 1.3V VDD for Time to Digital
Converter of DPLL

VDDMS H13 C7123 1.3V Mixed signal supply

VDDXO E11 C7130 1.3V DCXO supply

VDDMMD A12 NONE 1.3V VDD for Multi Modulus Divider of
DPLL
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RX HB troubleshooting
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Figure 42 X-Gold RX pin volts @ L7100(LB) / L7101(HB)

Transmitter troubleshooting

Transmitter troubleshooting overview
If the phone failure identified at maintenance step1&3 is transmitter fail, and then the phone should be set
to the TX check mode, and then follow the corresponding workflow below for troubleshooting.

Abbreviation and terms:
Specific abbreviations used in TX troubleshooting workflow are described here:

Abbreviation Definition

TXLB_PI_ATT R7107, R7112, R7105

TXHB_PI_ATT R7104, R7108, R7103

TXLB_H4FILTER C7108, C7120, L7504

TXHB_H2FILTER C7109, C7101, L7106

FEM_TxCtl VC1,VC2, VC3, PAEN

FEM_TxCtrlRes R7106, R7110, R7113,R7100

FEM_TxCtrlCap C7105, C7107, C7110,C7132

FEM_BatComp L7707, C7135, C7125, C7117, C7111
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Figure 43 TX checkpoints and component overview (measurement point marked with blue)
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TX LB troubleshooting
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Figure 44 X-Gold TX pin volts @ C7108(LB) /C7109 (HB)

Figure 45 RX LB FEM logic waveform (C1:VC1; C2:VC2; C3:VC3)
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Figure 46 TX LB VPC logic waveform-PCL5 (C1: VPC; C2: PAEN)
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TX HB troubleshooting
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Figure 47 TX HB FEM logic waveform (C1:VC1; C2:VC2; C3:VC3)

Figure 48 TX HB VPC logic waveform-PCL0 (C1: VPC; C2: PAEN)
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  Maintenance step 3- Local mode verification and calibration

Maintenance step 3- local mode verification and calibration
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  Maintenance step 4 –Signalling mode test

Maintenance step 4 –Signalling mode test

  NOKIA CARE SUITE Testing and Tuning Tool

General

General
Care Suite (CS) is multi-protocol service software that supports Nokia TD-SCDMA, CDMA, GSM and WCDMA
products. Please see product specific technical bulletins for phone model specific information and
instructions.

Important: This document does not claim to be exhaustive. The actual software install or uninstall process
may vary from this description depending on the computer hardware used, the software already installed
and the entries in the registry.

Close all applications before installing Nokia service software.

Read the information provided by the installation program carefully, it often points out important steps in
the installation!

Legal notice
Copyright © Nokia Corporation 2010. This material, including documentation and any related computer
programs, is protected by copyright controlled by Nokia Corporation. All rights are reserved. Copying,
including reproducing, storing, adapting or translating, any or all of this material requires the prior written
consent of Nokia Corporation. This material also contains confidential information, which may not be
disclosed to others without the prior written consent of Nokia Corporation.

License issues
OpenSSL license:

http://www.openssl.org/source/license.html
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Knowledge with Intelligence for Care Support (KICS)
Information and software for all Nokia products is available in Nokia Online / KICS Information Page (https://
icknowledge.online.nokia.com). After logging in with a valid user name and password, select the S&R
Documents category and then Service Sw sub category.

If you do not have access to KICS, please go to the site and click on Registration Request.

For each new software version, a description of the changes and modifications is made available in the form
of a service bulletin. You will find it in the Service Bulletins category once you select a specific model under
the subcategory list.

Installation path
A default installation path is provided (C:\Program Files\Nokia\Nokia Care Suite\TestingAndTuningTool).

Preparation

Preparation

Supported OS
• Microsoft Windows XP SP2

• Microsoft Windows 7

Minimum HW requirements
• CPU: Intel or Intel compatible 1 GHz or faster

• RAM: Minimum 1 GB

• Hard Disk: 300 MB available

• Product-specific service cable or service adapter

SW requirements
• Microsoft .NET Framework 2.0

• Microsoft Core XML Services (MSXML 6)

• Care Suite package: Nokia_Care_Suite_Store_<year>_<week>_<build_number>.msi where year, week and
build number are available.

• Product-specific data packages from Online / KICS Information Page, or via online access to Nokia Firmware
Repository (FiRe).

• GPIB drivers

• NI VISA Runtime (see next chapter for more information)

Other requirements
• As a part of Testing and Tuning Tool installation National Instruments VISA 4.62 Runtime is installed if it

is not exists already. The installation package of the VISA is downloaded from internet so online connection
is needed. If the workstation does not have online connection, the VISA can be downloaded from Online /
KICS Information Page.

• Note! It may happen that GPIB drivers must be reinstall after the VISA Runtime has been installed. This
kind of need has been noticed at least with CEC PCI-488 GPIB card.
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Download software from online / KICS information page
Before you install the Care Suite Testing and Tuning Tool software and product-specific data packages,
download them from Online / KICS Information Page and save them on your computer or a network server
in a suitable folder structure.

Turn off User Account Control
Note: This applies to Microsoft Windows 7 users only.

Before you start installation the User Account Control should be turned off. Go to Control Panel -> User
accounts -> Turn user account control on /off -> Uncheck UAC box -> click OK.

Installation

Installation

Installing Care Suite 2010.24.0.xxxx or newer
Care Suite Testing and Tuning Tool can be installed if Care Suite 2010.24.0.xxxx or newer exists. If it doesn't,
install it by following instructions described in Care Suite User Guide. Installation package and user guide for
Care Suite can be found in Nokia Online / Care Services / KICS Information Page.

Install testing and tuning tool
You can install Care Suite Testing and Tuning Tool on top of previous versions.

1 Locate file Testing_and_tuning_tool_<year>_<week>_<build number>.exe where year, week and build
number are variable. Installation package and user guide can be found in Nokia Online / Care Services /
KICS Information Page.

2 Double-click Testing_and_tuning_tool_<year>_<week>_<build number>.exe and follow the prompts for
installation.

3 If Fuse Drivers (CU-4 drivers) and/or NI VISA hasn't been installed earlier the following dialog appears.
Online connection is expected to download NI VISA package.  If your PC has no online connection to
internet, cancel the installation and install NI VISA package manually , please see step 4 below. Otherwise
click OK to proceed the installation.
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4 If there is no online connection to internet, cancel the installation and install NI VISA manually. Please
download executable file ( e. g. NI-VISA462.exe ) from Nokia Online / Care Services / KICS Information
Page, double-click NI-VISA462.exe and follow the prompts for installation. Please see step 8 below.

5 After you have manually installed NI VISA package, please continue Testing & Tuning Tool installation
from step 2 above.

6 Fuse Drivers were successfully installed.

7 Confirm to proceed with NI VISA installation by clicking Yes. No skips the VISA installation and the
installation continue in step 11.
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8 NI VISA is downloaded.

9 Downloaded package is extracted.
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10 Press Next to start NI-VISA installation.

11 Select “I accept…” and click next.

12 NI VISA is being installed.
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13 Care Suite Testing and Tuning Tool installation starts. Please note that if NI VISA and CU-4 drivers have
been installed this is the starting point for the installation. Click Next when space requirements
computing is done.  If your PC does not have online connection to internet, and you installed NI VISA
package manually, please continue manual installation from step 2 above.

14 Click Install to proceed with installation.
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15 Press Finish to complete the installation.

Troubleshooting: Care Suite does not exists
The following info dialog indicates that Care Suite has not been installed. Install Care Suite according the
instructions you can find from Nokia Care Suite User Guide.
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Troubleshooting: NI VISA not installed reminder
If NI VISA installation was skipped in some reason it is reminded when Care Suite Testing and Tuning Tool
installation ends.

Launching Care Suite Testing and tuning Tool

You can launch Care Suite in the following ways:
• If the “Shortcut on desktop” option was selected during installation, double-click the Nokia Care Suite

shortcut on the desktop.
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• If you used the default installation path, launch the application from C:\Program Files\Nokia\Nokia Care
Suite \ApplicationLauncher\Bin\applicationlauncher.exe or Start -> Programs –> Nokia -> Nokia Care Suite
–> Launch Nokia Care Suite.

Nokia Care Suite application launcher shows the available applications for use.

Application launcher

• To launch the Nokia Care Suite Testing and Tuning Tool, double-click on the Testing and Tuning Tool.

Layout
• Welcome screen is displayed when Testing and Tuning Tool is started.
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• When a device is connected, the device connection screen is displayed.

• The progress about device predetection, identification and product configuration.

Press Open Connection Management link to open Nokia Fuse application.
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Selection of the connected device

• When multiple devices are connected, use the drop-down menu to select the desired device.

• When you select a device, all the other panels will be updated for the selected device.

In the drop-down menu in addition to the connected devices two items are available:

• No connection – if it’s selected the welcome screen is always displayed (even if there are connected devices)

• Auto Device Selection – Care Suite will select automatically active connection (usually first connected
device)

Refresh button besides drop-down menu freshes the connection and behaves like new product is attached
and detected (device predetection, device identification and product configuration steps were executed.)
Refresh functionality can be used when connection paired with CU-4 service adapter is stuck.

If no device is connected an empty connections are available for selection. If you select an empty connection
(connection to which no device is associated) from drop-down menu the welcome screen is displayed:

Navigation menu
Select the desired tool. The tools (buttons) can be grayed based on connected device configuration.
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Product Information
Basic information is displayed for connected product. Right mouse click over the Product Information columns
make possible to hide items (columns) or make them visible again.

Action Report Log
• Logs all activities done for a particular device by serial number.
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• By default Action Report Log files are located in C:\Documents and Settings\All Users\Application Data
\Nokia\Nokia Care Suite\Logs\Action Reports and the default storage time is 30 days.

• Action Report Log path and storage time can be changed in File -> Preferences -> Logs.

Configuration of testing and tuning tools

Configure connections between phone and PC
Connections can be managed by Nokia Fuse. This is described in Nokia Care Suite User Guide. One important
addition is added here relating Service Adapter (CU-4) used. When connection is configured it must be
“paired” with CU-4. Tick “Pair this connection with service adapeter” choice in connection settings dialog.

Paired service adapter and connection is visible in Fuse Overview.
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Preferences
Testing and Tuning Tool can be configurated via Preferences dialog. Go to File -> Preferences.

Tools tab
Tools to be shown in tools panel can be configured in Tools tab.
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Network tab
Select if you use proxy setting and set configuration if manual proxy has been selected.

Administrator tab
• Operating mode:

Select what operating mode of the Care Suite you want to use. Offline mode – will use data packages from
local hard drive. Online mode – will try to connect to a server which contains latest data packages.

• Product Information File:

Select whether you want to disable creation of the Product Information File, use the default folder, or
define a folder. Folder icon opens view to folder where Product Information Files are.
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Logs tab
Destination folders for logs files can be configured here.
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Data Packages tab
• Software package path: Destination path for downloaded data packages. The path is also included by

default in package search paths.

• Package search path: List of search paths of data packages.
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RF tuning

RF Tuning tool is opened from navigation panel or Tools –> RF Tuning menu. If data package is found for the
attached product the following screen is displayed.
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An upper part of RF Tuning Tool (RF Testing Tool too) view has controls for cables, splitters and shield boxes
defined by Nokia. A right e.g. cable must be selected because then RF Tuning has different attenuation values
for different cables, splitter and/or shield boxes. Splitter consists of splitter itself and cables to splitter (here
CA-178RS). Selections in drop down lists remains even though tool is closed and opened again so there is no
need to make selection if tuning environment remains from hardware point of view. Note that a product
specific loss in the attenuation chain comes from data package and RF Tuning summarizes all losses into one
from connection in product/module jig to instrument.

A different kind of RF tunings can be executed by RF Tuning Tool. It depends on product how many different
sequences there are. All possible tunings (sequences) are listed in Sequences drop down list (picture below,
left one). As an example (picture below, right one) product has two sequences: Cellular RF Tunings and Tests
and WLAN Tunings and Tests. Some products may have also FM TX tuning.

An actual execution for the sequence begins when the user clicks “play” button (picture below, button at far
left in three-button group). The execution can be stopped by clicking “stop” button (in the middle of three-
button group). It does not stop the execution immediately but an ongoing step in the sequence is ended
first. A “folder” button (at the right in three-button group) opens a window where log files, the execution
produces, are located.

A status of the execution is shown with the execution result “ball”. A status of the execution is indicated with
colors:

• Grey – the sequence hasn't been executed yet. The ongoing execution is shown as rotating tiny balls.

• Green –the sequence has been executed successfully.

• Yellow – the sequence execution has been stopped and all executed steps were passed successfully.

• Red – The execution was done but some step failed (e.g. limit fail), or the execution stopped due the fail
or the execution was stopped and some step in already executed steps failed.

All steps in the sequence are shown in the sequence view (below). The progress of the execution is shown
with the status indicators (balls): grey with arrow – the execution of step is ongoing, green – step passed
successfully and red – step failed.
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The results for the tunings and/or tests can be seen when the execution is ended (stopped by user, stopped
due the error or after all steps were executed). If there are “fails” (step status is red), the results for the first
fail is shown immediately when the execution ends. If all steps were passed successfully the results are not
shown automatically but the user must click wanted step in the sequence view to see results for that step.
All results are scrollable by clicking the root of the tree view. The result view can be closed or open again by
clicking small arrow (see tiny red rectangle in the middle of the picture below) in the sequence/result view.
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Some results are checked against limits. If the value is not between “Min” or “Max” it is shown with red status
indicator. It is also shown if the value is below “Min” or bigger than “Max” by highlighting the limit. The limit
fail turns also the status of step and sequence to “red”. The limits come from data package and those are
product specific.

All information shown in the result view is written to the log file during the execution.

RF testing

RF Testing tool looks visually same like RF Tuning tool. There are same controls for cable, splitter and shield
box selections.
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EM calibration

EM Calibration works with same principles like RF Tuning and RF Testing. Some controls like cable, splitter
and shield box selection are not visible here. The execution is started and stopped like in RF Tuning and RF
Testing.

The results of the execution are shown like in RF Tuning or RF Testing. The results are written to the phone
if it is between the limits. If not, then the old value remains in the phone and “saving” step is marked as a
fail (red indicator).

Notes

Microsoft, Windows, Windows Vista and Windows XP are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

NI VISA Runtime Copyright © 2010 National Instruments Corporation. All Rights Reserved.

  Bluetooth Troubleshooting

Bluetooth functional description
The device supports Bluetooth 2.1 + EDR (Enhanced Data Rate).
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The Bluetooth device UART interface allows the device to communicate with the phone baseband engine
using Bluetooth HCI (Host Control Interface) commands. When Bluetooth is switched on, the phone user
interface the BT_RESETX line is toggled to reset the Bluetooth device, and commands are sent over the UART
interface to configure the device. If UART communication fails (due to a hardware fault) it will not be possible
to switch on Bluetooth from the phone user interface.

The device has two clock signals: SYS_CLK (26.0MHz) and SLEEP_CLK (32.768kHz). The SLEEP_CLK is supplied all
the time the phone is switched on. To maximise the phone standby time, it is only necessary to provide a
SYS_CLK signal when Bluetooth activity occurs, such as sending Bluetooth data to another device, or checking
periodically if there are any other Bluetooth devices attempting to communicate with it. At other times when
the Bluetooth device is in standby mode it is only necessary to provide a SLEEP_CLK signal. The Bluetooth ASIC
is powered directly from the phone battery voltage line (VBAT). An internal regulator is enabled when
Bluetooth is switched on.

Bluetooth audio signals are sent to and from the device using a PCM interface. The Bluetooth RF signal is
routed via a buried track to the Bluetooth antenna on the side of the PWB. An RF filter is needed between
the Bluetooth antenna and Bluetooth ASIC to prevent interference to and from the cellular phone antenna.

Block diagram
The following block diagram shows how Bluetooth is connected to the host engine.
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Figure 49 Bluetooth block diagram

Interface signals

Table 2 Bluetooth Signal List

Signal Name I/O Function Notes

RF

BT_ANT B Bluetooth Antenna Port

Clocking

SYS_CLK I Cellular engine RF clock
(26.0 MHz)

SLEEP_CLK I Cellular engine sleep
clock (32.768kHz)

Bluetooth Control

BT_RESETX I Bluetooth ASIC reset
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Signal Name I/O Function Notes

CLK_REQ O Signal from Bluetooth
ASIC to indicate that
SYSCLK is required

UART_WAKEUP O Signal from Bluetooth
ASIC to wakeup host
engine

BT_WAKEUP I Signal from host engine
to wakeup Bluetooth
ASIC

Bluetooth Communication

UART_RX I UART interface to/from
host engineUART_CTS I

UART_TX O

UART_RTS O

Bluetooth Audio Interface

PCM_IN I PCM interface to/from
host enginePCM_OUT O

PCM_SYNC I

PCM_CLK I

Power

VIO P Cellular engine I/O
supply

VBAT P Phone battery power Alternative connection
to 1.8V supply could be
used

Component placement
The Bluetooth ASIC, is checked when troubleshooting (if supported).

The placement of Bluetooth and test probe points is shown below.

The Bluetooth antenna is product specific (PWB track, SMD antenna, clip on antenna, or antenna integrated
into phone covers) and is typically located near the side of the PWB.
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Figure 50 Test points in Archie Bluetooth ASIC circuit – BTHCost4.0D (CSR8810)

Symptom, Problem and Repair Solution
The following problems can occur with the Bluetooth hardware:

Symptom Problem Repair Solution

Unable to switch on Bluetooth on
phone user interface

Open circuit solder joints or
component failure of BTH ASIC,
BB ASICs, or SMD components.

Replacement of Bluetooth ASIC

Able to send data file to another
Bluetooth device, but unable to
hear audio through functional
Bluetooth headset

Open circuit solder joints or
component failure of BTH ASIC,
BB ASICs (PCM interface).

Replacement of Bluetooth ASIC

Able to switch on Bluetooth on
phone user interface, but unable
to detect other Bluetooth devices

Open circuit solder joints or
detacted component in
Bluetooth antenna circuit.

Repair of Bluetooth antenna
circuit

Problems connecting to specific
manufacturer/model Bluetooth
accessory (specific Bluetooth
profile supported by phone and
accessory in product
specification)

Possible interoperability issue
with accessory fixed in recent
Nokia phone software release
(check Nokia Service Bulletin for
latest information)

Update phone software to latest
version if advised in Nokia Service
Bulletin.

Note: The phone Bluetooth
Address and software version are
displayed by pressing *#2820#
when Bluetooth is on.
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Users may experience the following problems resulting in functional phones being returned to the repair
centre:

Symptom Problem Solution

Bluetooth feature does not
operate as desired with another
Bluetooth device

Bluetooth Profile implemented in
Bluetooth accessory not
supported in Nokia phone

Use Bluetooth accessory with
Bluetooth profiles supported by
phone

Test Coverage
The tests listed in the table below should be performed to verify whether the Bluetooth is functional.

Bluetooth should be re-tested after repair to the Bluetooth circuit (if supported by the phone).

Test Test Coverage Repair solution

Bluetooth Self Test:
ST_LPRF_IF_TEST

Bluetooth ASIC UART interface
(controls Bluetooth receiver and
transmitter)

Replacement of Bluetooth ASIC
(or repair of phone BB)

Bluetooth Self Test:
ST_BT_WAKEUP_TEST

Bluetooth ASIC interrupt control
interface

Replacement of Bluetooth ASIC
(or repair of phone BB)

Bluetooth Self Test:
ST_LPRF_AUDIO_LINES_TEST

Bluetooth ASIC PCM interface Replacement of Bluetooth ASIC
(or repair of phone BB)

Bluetooth Functional Test: BER
test with BT-Box or functional
test with other Bluetooth device

Bluetooth antenna circuit Repair of Bluetooth antenna
circuit (including RF filter)

The self tests run from Phoenix software are used for fault diagnosis.

If Phoenix software is not available the functional tests with phone accessories are sufficient to verify the
functionality of Bluetooth.

Test Procedure

Bluetooth Self Tests
A CA-101 phone data cable connected to a PC with Phoenix service software is required.

Steps:

1 Connect data cable to phone.

2 Start Phoenix service software.

3 Choose File → Scan Product.

4 From the Mode drop-down menu, set to Local.
5 Choose Testing → Self Tests.

6 In the Self Tests window check the following Bluetooth tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST

7 To run the test, click Start.
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Bluetooth BER Test
SB-6 Bluetooth test box (BT-box) is required to perform a BER (Bit Error Rate) test. If a BT-box is not available
Bluetooth functionality can be checked by transferring a file to another Bluetooth phone.

Steps:

1 Place the phone in the flash adapter or connect data cable to phone.

2 Start Phoenix service software.

3 Choose File → Scan Product.

4 Choose Testing → Bluetooth LOCALS

5 Locate the BT-box serial number (12 digits) found in the type label on the back of the SB-6 Bluetooth test
box.

6 In the Bluetooth LOCALS window, write the 12-digit serial number on the Counterpart BT Device
Address line.

7 Place the BT-box near (within 10 cm) of the phone and click Run BER Test.
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Bluetooth troubleshootin

Troubleshooting flow
The specific troubleshooting fault repair chart only needs to be followed if there is a fault with a particular
function.

VBAT C6019

VIO C6010

C6012 1.7 – 1.95
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C6001, C6002, C6003, C6004 no longer present

C6005, C6011, C6020 1.35V

C6009 1.14V
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  Baseband System Module

Overview
This section contains a brief overview of the key features of the Quantum engine, as well as overview
descriptions of implementation details.

Introduction: phone description
Quantum is a low cost dual band GSM/EDGE RX platform based on Infineon’s X-GOLD213, containing RF
transceiver, baseband processor and power management unit on a single IC.

Physical:
• Low component count

• 4 layer PWB, single sided mounting

• PWB structure: 4 layers, 1+2+1 build-up with micro-via

Power:
• Support for Li-Ion batteries

• Support Nokia 2mm charging specification

• Intelligent charge control with temperature and over-current and over-voltage protection

Memory:
• Up to 512Mbit (2Gbit*) NOR flash with burst mode access

• Up to 256Mbit PSRAM

• 296KB internal SRAM

• 1.8V memory supply

• * (constrained by overall IO mapping)

Audio:
• 700mW Class-D amplifier for IHF speaker

• Stereo DC coupled headset outputs

• Polyphonic ringing

• FM radio with RDS

• Voice CODECs. FR, EFR, HR, NB-AMR

• SB-ADPCM CODEC for true tone

SIM:
• Support for both 1.8V and 3V SIM.

• SIM supplied by dedicated LDO

MMI:
• Parallel and serial LCD interface

• Vibrator driver output

• 6 x 5 matrix keyboard with detection of 2 keys simultaneously pressed

• Step up for Serial connected LED’s for backlight of LCD and keyboard
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Camera:
• Parallel camera interface is natively supported by XG213

• CSI-2 type interface with interface IC

Removable storage:
• MMC/SD card

Accessories:
• Support for Signature type accessories

• Support for headset

• TTY support

Production support:
• Secure boot for flash image download

• USB/Serial protocols for flashing

Chipset and key components
The following table lists all major components in the design on baseband side.

Table 3 Chipset key components

Part Number Function Reference Designator

X-GOLD 213 V2.1S Engine IC D3100

K5N1266ACM-BT80 32MX16 NOR /4MX16 PSRAM D3000

STSMIA832 De-serializer for Camera N3000

BC8810 Bluetooth module N6000

26MHz DCXO B7100

32.768KHz crystal B3000
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BB block diagram

Figure 51 Quantum block diagram

Display
Quantum includes a 128x160, 16bit color display. The display interface has two supply voltages: 2.8V for LCD
controller and 1.8V for LCD controller I/O. The display interface is driven by the DIF (Display Interface) of the
X-GOLD213. For more details on the DIF please consult the X-GOLD213 spec.

Camera
The Camera is interfaces to the XGold213 trough a de-serializer chip, which converts from the CCP2 serial
data/clock from the camera to the 8 bit parallel interface on the XG213.

MMC/SD-card
The MMCI interface of XGold213 is used for external data storage on a SD card. The interface supports up to
52MHz clock rate, giving a peak data bandwidth of 200Mb/s.

Backlight
The LCD backlight is designed around an integrated step-up converter in X-GOLD213, which enables high
voltage generation for the serially connected LED’s in the LCD.

The current trough the LCD backlight LED’s is sensed by a resistor and can be controlled by an XGOLD213
register.
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Optionally a separate keyboard backlight can be driven by a constant current sink supplied from VBAT and is
controlled from a GPIO. The keyboard backlight supports white LED with low Vf.

Keyboard
The current CHWP is designed with a 5*5 matrix keyboard i.e. up to 25 keys plus the ON key, XG213 can
support up to 6*5 which means that up to 30 keys* plus the ON key can be detected. ESD protection is optional
by providing PWB footprints for tranzorbers. If needed, these tranzorbers can be mounted. The tranzorber
footprints are physically located in a way which enables the use of the Nokia ASIP for keyboard protection,
with only minor PWB layout changes.

Note: Usage of the pin for the 6’th row is dependent on the port allocation.

Audio
The microphone, earpiece, speaker and headset are driven directly from the X-GOLD213. To obtain a sufficient
Sound Pressure Level from the speaker, a build-in class-D amplifier is used. The design supports both separate
transducer implementations as well as combined earpiece and speaker outputs, including support for 3-in-1
devices with integrated vibrator functionality.

The Engine supports two analog microphone inputs and optionally dual digital microphone inputs as well.

Vibrator
The vibrator function is supported using the VIB driver in the X-GOLD213. This driver features a VBAT supplied
push-pull output stage which is intended for driving a vibra motor. The engine also supports vibrating using
the 3-in-1 multi-actuator device, please refer to 3.3.6.

Accessory support
The accessory connector is the Nokia AV connector. The ECI function is not supported. USB data
communication is supported, but USB OTG is not supported. Also Janette headset and video cable are not
supported.

Baseband functional description

Baseband functional description
• Baseband function is mainly fulfilled on the XGOLD213 IC, which includes energy management, analog and

digital baseband. It has following function: Power supply for internal function blocks, and external chips,
like Bluetooth and external memory.

• MCU and DSP to control system in different operation modes.

• State machine of PMU in X-GOLD213 controls the power up sequence.

• 26 MHz and 32 KHz clock generation and distribution.

• Audio CODEC, power amplifier for loudspeaker, microphone (include digital microphone), earpiece,
headset.

• Battery interface and battery charge interface.

• Display interface.

• External NOR flash & PSRAM interface.

• External dual SIM card controller to extend up to two SIM card interfaces.

• Display backlight and keypad backlight driver.

• Keypad interrupt and scan.

• Deserializer for camera with serial interface.

• Support 4-bit SD memory card.
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• Drive vibrator.

• Support Bluetooth and FM module through UART and I2S ports.

System power up
The system power up sequence can be seen in the following figure.

The Power-on reset (POR) circuit and the LPBG are directly connected to the battery, If the battery voltage
exceeds the POR threshold (2.5V), the POR is released, the LRTC and LPMU voltage are switched on and the
internal PMU oscillator is started.

The power up sequence can be initiated by any of the following ways if there is a battery of a valid voltage
of above SYSONLEV (3.2V):

• First connect of VBAT with valid voltage has been detected

• Input “On” pin pressed ( goes from low to high)

• Input RTCOUT caused by programmed alarm in RTC block

• A valid charger detected and the battery is charged above the SYSONPRE voltage level

• A USB cable has been connected (external circuit)

The first startup of the PMU is based on local 50 kHz PMU oscillator. This eliminates delays caused by slow
startup time of the 32 kHz RTC oscillator. The SW can later change the input for the PMU clock to the 32 kHz
oscillator and switch off the PMU oscillator to save power. The PMU power up sequence is shown in the figure
below:
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Figure 52 Power up timing and system sleep

Where the system after VBAT is applied goes first into the system OFF state. Connection of a valid battery
voltage (VBAT > 3.2V) will initiate a system startup, other valid system startup causes are pressing the ON
key, connection of a USB cable or charger, or a RTC alarm event.

When the system is in OFF state, only VRTC and VPMU are activated, with the common reference generated
by the low power band-gap reference LPBG. Upon detection of a valid turn-on event, first the high precision
band-gap reference is turned on, then the 1.8V step-down converter SD1 and the VCORE LDO are turned on
controlled by the PMU HW state-machine. The control signal RF_SYSCLK_EN is asserted to power up the DCXO
regulator in the RF macro, and after the DCXO has stabilized, the 26MHz system clock is available. The RESETX
signal is released 16ms after assertion of RF_SYSCLK_EN.

When RESETX is released, activation and control of the remaining supplies is done by SW, hence no exact
timing figures can be given here. The SW will, as one of the first actions, enable the 32 kHz oscillator and
enable the digital SLEEPCLK output, and turn on the 2.85V VAUX regulator. Control of remaining supplies (VSIM,
VMMC, VUSB, RF supplies) is handled by the respective SW drivers.

RM-704
System Module

Page 5 – 10 COMPANY CONFIDENTIAL Issue 1
Copyright © 2011 Nokia. All rights reserved.



The following figure provides a more SW oriented view of the system startup or boot process. The upper part
contains the HW controlled part of the startup sequence up until release of the RESETX reset signal. After this
the boot ROM starts executing, validating the flash PSI and detecting if a flashing process is requested over
the USB interface.

Depending if a flashing process is requested or not, the boot ROM code will either exit and the flash PSI
followed by normal system code will be executed in the case of a normal startup, or the flashing process will
be initiated by downloading and executing the RAM PSI from the flashing host.

Figure 53 System startup, SW view
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Modes of operation
Figure 2 also shows the sleep mode transitions in a PMU context. When the system enters sleep mode, the
state of a number of the power management functions will be changed controlled by the RF_SYSCLK_EN signal
to reduce current consumption. Most devices can be put into off or standby mode such as the LDOs and DC/
DC converter, to minimize quiescent current. The DC/DC converter can be programmable into its low power
mode (PFM) and VCORE changes the output voltage to a lower value. The HPBG (HIGH PRECISION BANDGAB) is
deactivated and the DCXO in RF is switched off.

Exit from sleep mode is initiated by expiration of the sleep timer or detection of a HW interrupt.

Power distribution
The X-GOLD213 contains regulators for all power supplies needed in various parts of the chip. The regulators
are LDO type linear regulators except the 1.8V step down DCDC converter. The LDO’s are powered from either
battery or the step down converter. The following figure depicts the complete power management unit with
the regulators. Supply inputs VRF1 and VDD1V8 are connected to the output of the step down converter SD1,
thus increasing the efficiency of the downstream supplies for the RF, the digital core and the analog part by
the conversion factor of the step down. The remaining regulators are supplied directly from the battery
voltage.

Figure 54 X-GOLD213 power management unit
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The above figure shows the VPMU, VMMC, VSIM, VRTC, VUSB and VAUX LDO outputs of X-Gold213 together with
the output decoupling capacitors. VANA is implemented with a cap-less LDO, hence this supply is not available
on any X-Gold213 balls. Main part of the system is powered from a 1.8V supply rail. This voltage is generated
by the integrated step down converter (SD1) which needs only an inductor L2204 plus input and output
decoupling capacitors C2207 and C2206.

Figure 55 Power supply distribution

The above figure shows the power supply distribution of Quantum for the supplies which are used outside
the X-Gold213. Regulators in the X-GOLD213 convert the battery voltage VBAT to regulated supplies for the
various peripherals. The SD-card features dedicated regulator. A shared supply concept is used for other
peripherals. This means in general that there is no power on/off control implemented for the shared supplies,
these regulators will be enabled always when the system is on.
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Clocking concept

Figure 56 XG213 clock generation and distribution

The above figure provides an overview of the clock generation and distribution inside XGold213. The 26MHz
DCXO is located in the RF macro and supplies the XGold213 with the main clock input. This clock is optionally
available also on the FSYS1 and FSYS2 outputs as sine wave outputs. In Quantum only FSYS1 is used for the
BTFM module. The 26MHz signal from the DCXO is buffered and made available for the digital part of the
XGold213 through the CGU (Clock Generation Unit). Here a PLL and phase shifters generate higher frequency
clock signals which are then fed to the various on-chip HW blocks through a set of multiplexers and dividers,
allowing for a very flexible clocking scheme. The clocks are also available a digital clock outputs on the CLKOUT
[0:2] balls. Currently in Quantum CLKOUT0 is assigned for the 32 kHz SLEEEPCLK, and CLKOUT2 is assigned for
the camera clock, and CLKOUT1 is not used.

The low power 32 kHz oscillator is enabled under SW control and is available during system sleep for all HW
blocks to allow operation is sleep mode with very low power consumption.

Audio concept
The VMIC supply is intended for the biasing of the internal microphone and the VUMIC for the biasing of the
headset microphone. There are 4 voltage settings for VMIC and VUMIC ranging between 1.8V and 2.2V. The
default setting for both supplies in XMM2130 reference design is 2.2V. VUMIC has an ultra-low-power mode
which is used only when a headset is connected and the mobile station is in sleep mode. To be able to detect
a key press on the hook key, the bias supply needs to be enabled. VUMIC is switched to the standard mode
during audio operation for optimal noise performance.
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The internal microphone inputs via filtering components to the MICP1 and MICN1 inputs of XGold213. DC
blocking capacitors C2102 are inserted to center the audio input around the internal bias level. The
microphone circuit is configured in pseudo-differential mode. VMIC is used for the bias. A low-pass filter
comprising R2100 and C2101 is used to remove any potential noise picked-up by VMIC. The external
microphone for the headset is connected via filtering components to the second differential microphone
input MICP2 and MICN2, and is designed pseudo-differentially for better noise immunity. DC blocking
capacitors C2107 are used for the biasing. A low-pass filter comprising R2105 and C2105 removes any
potential noise picked-up by VUMIC. As a relatively high gain is applied to the uplink signal in the X-GOLD213,
a noise suppression filter is inserted. Microphone signals are connected differentially between X-GOLD213
and filter circuitry in order to achieve a good common mode noise rejection.

Downlink audio can be routed to the headset output drivers, earpiece driver or the class-D speaker amplifier.

Figure 57 X-Gold213 audio output selection

The X-Gold213 features stereo headset drivers, each driving a 16ohm load with an output power up to
30mWrms. With different register settings, either a stereo or mono configuration can be selected. In the
mono configuration, only the R-DAC is used, with the signals still routed through to both HSR and HSL. The
X-Gold213 also contains a charge pump which is used to supply the internal headset amplifier in bipolar
mode (generates -1.3V). When using this mode, the external DC blocking capacitor can be removed. For
Quantum only bipolar mode will be supported. For this application an external capacitor C3016 is connected
to the CP1 / CP2 balls. The charge pump is driven by a 13 MHz clock.

The EP buffer (EPP and EPN) is specified to have a max power output of 100mWrms, at a load16ohms.

Figure 58 Dual and single speaker configurations
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Quantum supports dual or single speaker configuration. Single speaker configuration is used when having
either just a single speaker for both IHF and normal handset operation, or when using a multi-actuator or 3-
in-1-device with integrated vibrator functionality. For single speaker configurations 3.9 Ohm serial resistors
must be inserted in the earpiece driver outputs as indicated in the above figure to isolate the driver from
the low speaker impedance.

The X-GOLD213 has an integrated Class D power amplifier (LSP/LSN) that can drive an 8ohm load at the
maximum rating of 700 mW rms (at VBATmax). The Class D amplifier is supplied directly by the phone battery
and therefore the driving capability depends on the battery voltage.

The default switching frequency of the amplifier is initially set to approximately 600kHz, but may be varied
between 400kHz to 800kHz in the case of harmonic interference to the GSM RF frequencies or FM radio receive
channel. External ferrite beads L3100 and L3000 have been added on the amplifier outputs to minimize
interference.

Figure 59 Speaker outputs with ferrite filters

Baseband electrical interfaces: Battery
X2080 is battery connector, battery supply voltage range is 3.2V to 4.2V. The middle pin of the connector is
for battery ID, the BSI resistor value should be 68K (default value, normal mode without charging) or 3.3K
(test mode), the nominal resistance of actual NTC resistor is 47K at room temperature.

Baseband electrical interfaces: Charger
Charge voltage is detected by an external voltage divider. The voltage (VCHG) is measured by a 10-bit PMU
ADC with a dynamic range from 0 to 1.2V. The maximum ADC voltage corresponds to 32.4V with the current
external divider ratio hence the resolution is 31.6mV/LSB.

In order to validate the charge voltage, an upper and a lower limit are programmed in the PMU charger
control registers. These registers can be programmed by SW during run-time. During HW controlled
precharge, the reset values are set to allow a nominal charge voltage range of 4.1 to 10.0V. Upon charger
detection, the charger voltage is compared against the charge voltage limit register values, and charging is
only done if the voltage is within the allowed window. When SW is running the charger detection window
can be re-programmed to comply with product specifications. In Quantum the charge detection window will
be set to comply with Nokia 2mm charging specification for normal and special chargers.
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Figure 60 X-Gold213 reference charge circuit

Baseband electrical interfaces: Display(s)
The X-Gold213 DIF module provides the flexibility for the main processor to communicate with an external
display of various possible type of interface.

In order to establish communication to different displays the DIF supports the low-level part of the protocol
which can be configured via several registers. The low-level part covers the number of pins, their functionality
and polarity. It also covers the timing parameters for the serial or parallel access of reading from or writing
to the display.

The DIF module provides the following main features:

• Serial interface (supports up to 26 MHz clock rate)

• 8/9 bits high speed parallel interface with programmable timing requirements

• Multiple input formats possible: RGB up to 32 bit/pixel

• Hardware accelerator for physical protocol (pixel-bit conversion) allows to generate all common output
formats for various colour depths, for example (R,G,B) =(3,3,2), (4,4,4), (5,6,5), (6,6,6), (8,8,8).

• Provision of synchronization signals to eliminate tearing effects (only in combination with the parallel
display interface)
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Figure 61 Serial display connection

Quantum supports both serial and parallel displays, as well as combinations of the two. The figure below
shows how the display interface signals in XGOLD213 are mapped to the parallel and serial interfaces of the
display(s). The Rx resistor is only needed when using dual displays, where one has serial and the other a
parallel interface. The resistor will limit the maximum achievable bit rate in the receiving direction (LCD read)
to app 3.25 Mb/s due to the RC filter constant created by Rx and the DIF_D1 input capacitance (Assuming Rx
= 2.2 kOhm and Cin = 10 pF). In single serial display applications Rx should be shorted (MESSI_CMT0 and
MESSI_CMT1 shorted).

In a dual display configuration, a GPIO must provide the chip select output for the serial connected display.

Figure 62 Display interface (parallel and serial coexist)

Baseband electrical interfaces: Memory
The memory subsystem of the Quantum supports the following features:

• Up to 512Mbit NOR flash memory

• 1.8V supply voltage for low power operation

• 16 bit bus width, A/D Muxed
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• Burst mode access (up to 78MHz)
• 16KB Instruction cache
• Up to 128Mbit/256Mbit PSRA
• 1.8V supply voltage for low power operation
• 16 bit bus width, A/D Muxed
• Burst mode access (up to 78MHz)

The product utilize Nokia Combo memory ball out. 4x10 or 6x10 matrix, D3000 is address and data bus
multiplex part in the design.

Figure 63 Memory interface connection

Baseband electrical interfaces: SIM
The Universal Subscriber Identity Module or USIM card is the logical extension of the SIM card into the 3G
environment, as an evolution of the SIM card. It can be used for support of GSM Phase 2 and 3G modes.

The X-GOLD213 USIM interface is compatible with ISO 7816-3 IC card standard, required by GSM11.12 (3.0V
and GSM 11.18 (1.8V) standards. It supports both 1.8V and 3.0V SIM Cards with T=0 and T=1 protocols
supported by hardware. For 3V SIM cards, the nominal supply voltage is 2.85V. The SIM card is provided with
a 3.25MHz clock and can be configured into low power modes. All SIM related clock signals are controlled by
the SIM_CTRL register in X-Gold213.

Figure 64 SIM card holder and signal protection
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For ESD protection of the SIM interface signals, an integrated ESD/EMI suppression component is used. A 100nF
capacitor is located very close to the SIM card connector for supply decoupling. The Design of the X-Gold213
IO’s ensures that all SIM signals are actively driven low as long as a valid battery voltage is present, even in
off mode, to comply with ISO7816-3 specifications.

Baseband electrical interface: Dual SIM
Dual support in Quantum is implemented using a dedicated dual SIM interface IC, LFH1001 from Infineon.
The LFH1001 is a dual SIM card interface IC for use in mobile stations. It has two LDOs to provide power
conversion for 1.8V and 3.0V and three level shifters per SIM card for signal level translation.

The LFH1001 interfaces between a baseband IC and two SIM cards. The LFH1001 multiplexes the signal paths
of the two SIM cards so that one will be connected to the SIM interface in the baseband IC, while the other
is left in clock stop mode. This allows both SIM cards to be powered and provides a flexible and efficient way
of switching between the two cards without having to execute repeated de-activation and activation
sequences in order to access the two cards.

Figure 65 Dual SIM using LFH1001

The LFH1001 has an integrated detection of SIM card presence based on two application concepts:

• Battery detection in case one or both SIM cards are located behind the battery

• Contact detection in an external card reader, in case one SIM is located in a directly user accessible slot

The LFH1001 contains logic for detecting the state of the SIM cards and performing automatic shutdown of
the SIM interface signals in case removal of the card is detected.
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Baseband electrical interfaces: Audio components
DC blocking capacitors C2102 are inserted to center the audio input around the internal bias level. The
microphone circuit is configured in pseudo-differential mode. VMIC is used for the bias. A low-pass filter
comprising R2100 and C2101 is used to remove any potential noise picked-up by VMIC.

The external microphone for the headset is connected via filtering components to the second differential
microphone input MICP2 and MICN2, and is designed pseudo-differentially for better noise immunity. DC
blocking capacitors C2107 are used. VUMIC for the biasing. A low-pass filter comprising R2105 and C2105
removes any potential noise picked-up by VUMIC.

Figure 66 Earpiece and loudspeaker components

R2511 and R2510 are matching resistor to adapt to high impedance of IHF.

Baseband electrical interfaces: Backlight and illumination
The backlight supply is implemented using the integrated boost converter control circuit of X-Gold213.

The converter circuit is running in the analog feedback control mode, where the on time of the NMOS switch
V7009 is controlled by a comparator triggered by the inductor peak current, while the off time is controlled
by a counter, which resets the NMOS switch when it reaches a pre-programmed value.
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Figure 67 Step-up backlight driver

Baseband electrical interfaces: Keyboard
The key interface supports a 5 x 5 matrix. There are two different modes of operation: standby mode and
active scanning mode.

In standby mode all scan output rows KEYOUT[0:#] are set to low. The scan input columns lines KEYIN[0:#]
are pulled high by internal pull-up resistors. In case of a key press, the corresponding KEYIN will be pulled
low. The logic states of all the input lines are AND’ed internally in the GOLD213 to generate an interrupt
request to wake up the CPU if any key is activated during standby. In case of interrupt, the CPU will read the
corresponding row and initiate an active key scan to identify the correct column. The key interface will also
allow detection of two simultaneously pressed keys.

The PWRON key is for power on function, it is pull up by VRTC.

Baseband electrical interfaces: Camera
The X-Gold213 CIF is a high performance camera interface block that implements the complete video and
still picture input interface solution for mobile phone applications. It supports a maximum input frame
resolutions of up to 3MPixels (2048x1536 pixels).

Since X-Gold213 does not support a serial camera interface, an interface, or de-serializer, IC is used. This IC
converts the CCP-2 compatible serial camera data to an 8-bit parallel format compatible with the XGold213
camera interface.
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Figure 68 Camera de-serializer for serial camera module

Baseband electrical interfaces: Memory card

Figure 69 SD-card interface

The XGold213 MMCI interface is connected to the SD-card connector through an ASIP R3200 providing EMI
filtering and ESD protection. A build in switch in the connector X3200 provides a logic signal for detection of
card insertion and removal.

Baseband electrical interfaces: Vibrator
The vibrator function is supported using the VIB driver in the X-GOLD213. This driver features a VBAT supplied
push-pull output stage which is intended for driving a vibrator motor. The engine also supports vibrating
using the 3-in-1 multi-actuator device.

Figure 70 Vibrator circuits
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Baseband electrical interfaces: BT module
The BTRDS device is interfaced to the Quantum engine. An asynchronous serial interface with HW flow control
implemented on the XGold213 USIF1 HW block provides the control/data interface, with optional digital audio
data interface provided with an I2S interface. The interface furthermore supports a bidirectional wake up
mechanism through dedicated signals UART_WAKE and BT_WAKEUP in. The Quantum engine also provides a
32 kHz sleep clock output and a 26MHz main clock to the BTRDS device. Activation of the 26MHz can be
requested by the BTRDS device by asserting the BT_CLK_REQ signal.

Figure 71 BT circuits

  RF System Module

Overview
This Chapter contains a brief introduction to the design of the RF part for the Quantum engine block in order
to give the maintenance operator a good knowledge of the RF HW for making debugging and troubleshooting
easier.

The assumption is that the service centre is equipped according to the Nokia’s Level 3 as described in
“Recommended service equipment, for authorized Nokia service suppliers” Version 30, 01 Nov. 2009 by
Nokia.

RF general description
The RF part of the Quantum engine is a 2G block using the Infineon X-GOLD213 IC RF sub-system as the RF
transceiver module, which supports dual-band GSM voice and data applications (GPRS class 10 with the
feature of RX EGPRS capability). It also supports 2 different Front End Modules, FEM, (Renesas EU and Skyworks
EU) includes both dual-band power amplifiers and antenna switch for RX/TX path switching functionalities.
The 26MHz reference clock is generated by a build-in digitally adjustable oscillator with one off-chip crystal.
Furthermore the engine supports FM radio functionality with an on-chip FM radio block. The external circuitry
needed for the FM radio is the LNA and the antenna. BT is also supported with an external BT chipset.

Frequency plan
Quantum is a dual band engine, which supports either EU version or US version frequency bands. The
frequency plan and power class are shown in the following table.

RM-704
System Module

Page 5 – 24 COMPANY CONFIDENTIAL Issue 1
Copyright © 2011 Nokia. All rights reserved.



Table 4 Quantum Frequency Plan

Version Band Frequency Plan GMSK Power Class

EU GSM900 TX: 880-915MHz 4 (Max PCL5 = 33dBm)

RX: 925-960MHz

GSM1800 TX: 1710-1785MHz 1 (Max PCL0 = 30dBm)

RX: 1805-1880MHz

Regulators and power supply concept
In the X-GOLD213 IC, VRF1 and VDD1V8 are the regulated output voltages of the DCDC step down converter
and supply the RF, the digital core, and the analogue part. The remaining regulators are supplied by the
battery directly for increasing the efficiency.

The following figure shows the power concept of the X-GOLD213 IC RF sub-system.

Figure 72 Power concepts for X-GOLD213 RF sub-system

In the following table, the RF power supply names, IC ball numbers, description for use, and at which
components the supply voltage can be measured at are listed.

Table 5 Power supply voltages for the X-GOLD213 IC RF sub-system

Name Ball No. Test point Function

VBAT G14 C7134 3.6V typ. Battery voltage, supply voltage of
D2B LDO

VDDRF2 G13 C7106 2.5V D2B output voltage, part of RF supply

VRF1 H10 C7121 1.8V DCDC output voltage, supply of 1.3V
LDOs

VDDTRX B14 C7124 1.4V Transceiver supply

VDDTDC B12 C7131 1.3V VDD for Time to Digital Converter of
DPLL

VDDMS H13 C7123 1.3V Mixed signal supply

VDDXO E11 C7130 1.3V DCXO supply

VDDMMD A12 NONE 1.3V VDD for Multi Modulus Divider of DPLL
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RF block diagram

Figure 73 RF block diagram

TX path overview
The TX digital architecture in the X-GOLD213 IC is based on a fractional-N sigma-delta synthesizer to generate
the two outputs at the TX1 port and TX2 port; LB and HB respectively. At The TX outputs, the AC coupled
Capacitors are removing the DC from the X-GOLD213 IC, the RF signal is then harmonic filtered by a H4 filter
(4th Harmonic Notch Filter) for LB and a H2 filter (2nd Harmonic Notch filter) for HB (both filter are series
resonance filter to GND), and attenuated by a 2dB attenuator before the FEM (PA+ antenna switch). The input
signal to the FEM is a GMSK RF modulated carrier signal in the range of -3dBm to +3dBm. The PA amplifies
the signal to its wanted output power level (PCL of the GSM specification) determined by the amplitude level
of the Vramp signal. The RF output signal from the FEM is delivered to the RF connector (RF production/debug
connector) if a RF cable is present or to the Antenna Pad in case of no RF cable connected. A detailed description
of the TX path in the RF part of the Quantum engine can be found in Appendix B.

RX path overview
The RX signal is input from the Antenna or from the RF connector if the RF cable is attached to the production
RF connector. The RF signal is then input to the antenna switch of the FEM, where it is switched to either the
LB path or the HB path. This is controlled by the settings of FE1/VC1 (TX-RX Switch), PABS/VC2 (Band Select),
and FE2/VC3 (Antenna Switch configuration); see the FEM logic table in Table 7. The antenna input signal is
then band-pass filtered in the SAW filter module with the RX in-band frequencies as specified in Table 1. After
BP filtering the RF signal is matched to the impedance of the X-GOLD213 IC differential inputs for optimum
receiver sensitivity performance. In the X-GOLD213 IC the RX input signals are amplified by a Low Noise
Amplifier (LNA) and down converted to Low IF and again amplified before demodulated and signal processed.
A detailed description of the RX path in the RF part of the Quantum engine can be found in Appendix A.
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X-TAL/DCXO
The X-Tal and DCXO is the 26MHz Reference Clock used by the entire platform as an accurate clock. The clock
frequency can be controlled and adjusted by the embedded capacitor bank of the DCXO (Integrated in the X-
GOLD213). During synchronization to base-station or base-station emulator (Normal mode/signalling mode)
the accuracy of the clock should be max 0.1ppm, however in normal mode the accuracy can be ±60ppm
depending on the setting of the AFC DAC value.

Antenna detection
The antenna detection circuit is applied to determine if the antenna is mechanically mounted or not. The
antenna circuitry consist by a current sourced ADC from the X-Gold, that’s are sourcing the resistors R7454
and R7460 to the antenna pad E7454. The antenna has an 0  impedance @ DC to GND if mounted correctly.
The ADC (embedded in the X-GOLD213) measured the voltage and use this to evaluate if the antenna is
mounted or not, and if the antenna connection to the pad E7454/E7453 is okay or not. The detailed circuit
is shown in the figure below.

Figure 74 Antenna detection circuit

FEM ID/PA ID
The FEM ID (PA ID) is used for FEM identification depending on the different release, see Table 2 . For more
info regarding the FEM ID see Appendix E.
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Figure 75 Quantum B2 RF schematic (For Release 3, see Table 2 for components values of the other releases)

BOM release version and RF part list
Quantum has four release versions in terms of the FEM suppliers and EU/US variation. Rel.1 and Rel.3 are for
EU (GSM900/1800) version and Rel.2 and Rel.4 are for US (GSM850/1900) version. The FEM, SAW filters, and
RX matching networks are different for each release as shown in the table below. The PA ID resistor embedded
in the FEM, makes it possible for the X-GOLD to determine which release is used.

Table 6 Schematic differences between releases

Rel.1 Rel.3

BAND EU EU

C7114 2p2(2320520) 2p2(2320520)

C7129 2p2(2320520) 2p2(2320520)

C7115 3p9(2320526) 3p9(2320526)

C7126 3p9(2320526) 3p9(2320526)

L7100 15nH(3640122) 18nH(3640171)

L7101 5n6H(3646059) 5n6H(3646059)

N7100 Sky 77535 (4355168) RPF88140B (4355148)

Z7100 Epcos(4511256) Murata(4511258)

RM-704
System Module

Page 5 – 28 COMPANY CONFIDENTIAL Issue 1
Copyright © 2011 Nokia. All rights reserved.



Glossary

Nokia Customer Care

Issue 1 COMPANY CONFIDENTIAL Page Glossary– 1
Copyright © 2011 Nokia. All rights reserved.



RM-704
Glossary

(This page left intentionally blank.)

Page Glossary– 2 COMPANY CONFIDENTIAL Issue 1
Copyright © 2011 Nokia. All rights reserved.



A/D-converter Analogue-to-digital converter

ACI Accessory Control Interface

ADC Analogue-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BA Board Assembly

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic (type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2, UEME and Zocus

CCP Compact Camera Port

CDMA Code division multiple access

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSD Circuit-switched data

CSR Cambridge silicon radio

CSTN Colour Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analogue converter

DAC Digital-to-analogue converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo
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DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package

DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DTM Dual Transfer Mode

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evolution

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compatibility

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FM Frequency Modulation

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HSDPA High-speed downlink packet access

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity
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IR Infrared

IrDA Infrared Data Association

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

MP3 Compressed audio file format developed by Moving Picture Experts Group

MTP Multipoint-to-point connection

NFC Near field communication

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architecture

OMAP Operations, maintenance, and administration part

Opamp Operational Amplifier

PA Power amplifier

PCM Pulse Code Modulation

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board
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PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RDS Radio Data Service

RF Radio Frequency

RF PopPort ™ Reduced function PopPort ™  interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multimedia Card

RSS Web content Syndication Format

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noise ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCP/IP Transmission control protocol/Internet protocol

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPnP Universal Plug and Play

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC
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USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

VF View Finder

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WCDMA Wideband code division multiple access

WD Watchdog

WLAN Wireless local area network

XHTML Extensible hypertext markup language

Zocus Current sensor (used to monitor the current flow to and from the battery)
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